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Thank you for choosing our product. Please read the instructions carefully
before operation. Follow these instructions to ensure that the product is
functioning properly. The images shown in this manual are for illustrative
purposes only.

For further details, please visit our Company’s website
www.zkteco.com.



http://www.zkteco.com

Without the prior written consent of ZKTeco, no portion of this manual can be copied or forwarded in
any way or form. All parts of this manual belong to ZKTeco and its subsidiaries (hereinafter the
"Company" or "ZKTeco").

ZK is a registered trademark of ZKTeco. Other trademarks involved in this manual are owned
by their respective owners.

First of all, thank you for choosing our company's products. To better utilize all the functions in the
software, please read the manual of this product carefully before use.Without the written consent of
our company, no unit or individual may excerpt, copy any part or all of the content of this manual, nor
may it be disseminated in any form.

The products described in this manual may include software copyrighted by the Company and its
potential licensors. Without the permission of the relevant rights holder, no one may, in any form, copy,
distribute, modify, excerpt, decompile, disassemble, decrypt, reverse engineer, lease, transfer,
sublicense or engage in any other act that infringes upon the copyright of the aforementioned
software, except where such restrictions are prohibited by applicable law.

Due to the continuous updates of our products, our company does not guarantee that the actual
products will be consistent with this data. We also do not assume any disputes arising from the
inconsistency between the actual technical parameters and this data. Any changes will not be notified
in advance.

ZKTeco Industrial Park, No. 32, Industrial Road,
Tangxia Town, Dongguan, China.
+86 769 - 82109991
+86 755 - 89602394
For business related queries, please write to us at: sales@zkteco.com.

To know more about our global branches, visit www.zkteco.com.
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ZKTeco is one of the world’s largest manufacturer of RFID and Biometric (Fingerprint, Facial, Finger-vein)
readers. Product offerings include Access Control readers and panels, Near & Far-range Facial
Recognition Cameras, Elevator/floor access controllers, Turnstiles, License Plate Recognition (LPR) gate
controllers and Consumer products including battery-operated fingerprint and face template-reader
Door Locks. Our security solutions are multi-lingual and localized in over 18 different languages. At the
ZKTeco state-of-the-art 700,000 square foot 1SO9001-certified manufacturing facility, we control
manufacturing, product design, component assembly, and logistics/shipping, all under one roof.

The founders of ZKTeco have been determined for independent research and development of
biometric verification procedures and the productization of biometric verification SDK, which was
initially widely applied in PC security and identity authentication fields. With the continuous
enhancement of the development and plenty of market applications, the team has gradually
constructed an identity authentication ecosystem and smart security ecosystem, which are based on
biometric verification techniques. With years of experience in the industrialization of biometric
verifications, ZKTeco was officially established in 2007 and now has been one of the globally leading
enterprises in the biometric verification industry owning various patents and being selected as the
National High-tech Enterprise for 6 consecutive years. Its products are protected by intellectual
property rights.



Document Conventions

Conventions used in this manual are listed below:

GUI Conventions

Convention Description
Bold font Used to identify software interface template names e.g. OK, Confirm, Cancel.
S gl(l)lfcljtie-rlevel menus are separated by these brackets. For example, File > Create >

For Device
Convention Description

<> Button or key names for devices. For example, press <OK>.

[ Window names, menu items, data table, and field names are inside square
brackets. For example, pop up the [New User] window.

/ Multi-level menus are separated by forwarding slashes. For example,
File/Create/Folder.

Symbols

Convention

-

‘ M

Description

This represents a note that needs to pay more attention to.

[ B¢

The general information which helps in performing the operations faster.

The information which is significant.

Care taken to avoid danger or mistakes.

The statement or event that warns of something or that serves as a cautionary
example.
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® After selecting personnel, enabling the "APP Log In" feature will automatically send
an email to the individual with instructions on how to use the app.

Step: Enter Personnel = Employee List, after selecting the corresponding employee and clicking

"More" — "Enable APP Login", the system will automatically send an email notification to the selected

individual.

()ZKBio CVAccess

Personnel v

Department

Position

Dismissed Personnel
Pending Review
Custom Attributes

Parameters

@ Card Management

The content of the email notification is as shown in the figure below: The employee can directly follow

4

Personnel / Personnel / Person

Department Name

4 B General(2)
» O ITE)
» [ tito(0)
» [ Departamentos(0)
» 3 gymtime(0)
» [ ROGT(0)

» [3 Tecnologia y Redes(0)

» [J DG OFFICE(0)
» [ TECHTEAM(0)
» [ DBA()

» D Produccion(0)
» [ assasa()

» 3 Vecinos(0)

» 03 Test3(0)

» [ asd(0)

» O3 GYM(0)

» [3 Welling(0)

» [3 Banco(0)

Personnel ID Name Morer Q B &
G Refresh =¥ New  Tg Personnel Adjustments W Delete T Export & Import ~+ More
Personnel 1D First Name Last Name Department Name Card Number @ statistics ogin Enab.
Reset Self Login Password
z Heel General & o
68 View Face Picture
b2 b rd General 123456789

© Disable App Login

] Exiraciing Facial Templates:

Create Time

25/11/2025 18:32:56

25/11/2025 3:06:11

Car Plate No  car

OB O -

nivel de ac.

50 rows per page Jump To 1 11 Page  Total of 2 records

the guidance in the email to begin using the app login.

Person ID 7 has been successfully registered

Dear, HOSHI,

Your personal information has been successfully registered.
Here is your access credential information

Personnel ID: 7

First Name: ,HOSHI

Last Name:

Department Name: General

Device Verification Password:

Card Number:

You can download the ZKBio Zexus APP from the app store,
log in as Personnel, then click on Me to upload your
personal face photo (please make sure to upload a photo
with a clear face so that it can be synchronized to the device

far face recognition entry and exit). The operation steps are
shown in the figure below

step2: Step3:

in e
with your Personnel IDand password wploada facial photo
intial password: 123456)

D



Access Control

® Navigate Access > Access Rule: Personnel export from permission groups now
includes name field in exported data.

Step: Enter Access = Access Rule = Set Access By Levels, select the desired permission group(s) on

the left, then click the "Export" button. As shown in the figure below, enter the page password to
initiate the export of the permission group.

User Password®
File encryption
File Format

Data to Export (@ Al (max 100000 records)

The exported permission group is shown in the following figure, including: Level Name, Personnel ID,
First Name and Last Name.

Personnel Information of Access Level

Level Name \ Personnel 1D . First Name | Last Hame 1
HYC r 1 Vus | rod T




® Adda"PUSH Version" field display in the Attendance Device Menu.

Step: Enter Attendance — Attendance Management — Attendance Device,after checking the device,

click "View and Get Information" - View Device Parameters.

(JZKBio CVAccess

£ Attendance Management v

Attendance / Attendance Management f Attendance Device

e Serial Number Device Name: Device Model - QR @
By Area
— Subordinate Level ! < O Refresh @ Delete B Authorized Device & Device Control W Clear Device Data 2 Export
4 B AreaName Serial Number Device Name Device Model Firmwar_& Get Device Option \ttendance Area  Status  Entroliment Commands to be Ex. Ccurrent
Attendance Point
» [ Gerencia
Roll Call » [ Administracion
» [ Recursos Humano (2 Attendance Data Checking
Device Command
» [ Ventas (2 Re-Upload Data
Device Oy ation L » [ Legal
s o 3 Get the specifisd personnel data
» [ Almacen
» D Test
» [ Arrebe
» O Ukr
» O MY
» O TEALTO
» O tegeta
» [ comsetec
» [ idworld
Attendance Setting
- »Da
» [ Condominio
Schedule
Exception
Attendance Detail Report >
Daily Attendance Report >
Monthly Attendance R... >
Calculate Report
;
e S 11 50 rows per page JumpTo 1 /1 Page  Total of 1 records
Here you can view detailed device parameters, including the Push version.
ZKBio CVAccess E
YRSy TSGRl  Altendance / Altendance Management f Attendance Device
‘Serial Number | Device Name | | Device Mocel Device Area Stalus -] QR e
P g | i 0 O Refresh Delete Clear Dt Data ~ E; t
Attendance Device »“ [ Subordinate Level ! ¢ efresn @ Delete BT e » [B Clear Device Data 1 Expor
4 B5 AreaName Serial Number D’ Fiendznce Area Status Entroliment .. Commands to be Ex. Current
» [3 Gerencia Lanysp sy visuuy |
JIA1252700250 G . st ofiiine @ 2 0
Il » [3 Administracion |
) ¥ [ Hecursos Humano: Finger Vein Quantity 0/1000
Command » [ Ventas
Palm Quantity -1
e Operation Log » O Legal
» [ Almacen Punch Data 7/30000
» D Test
» 0 Ukr
Biometric Template Version:
» O MY
» O TEALTO Face b
b O tegeta
» 0 comsatec Fingerprint 10
» O idworld
Attendance Setting Finger Vein 3
rDa
+ 3 Condominio Palm Vein

Schedule

Exception

Attendance Detail Report

Daily Attendance Report

Monthly Attendan

Calculate Report

Firmware Version

Ver 8.0.4.3-20240116

Push Version

Ver 2.0.335-20220623

51 50 rows per page -

Jump To 1

/4 Page  Total of 1 records

OB O T~

Fingerprint Qu

0

0]

Fingerprint Qu

0

5)



® Automatic Report supports department selection, sending attendance records only
for the selected department to recipients.

Step: Enter Attendance — Attendance Setting — Automatic Report, click "New", and in the Report

Settings column, you can select the department name. After selection, only the attendance records of
the selected department will be pushed to the recipients.

New

Report Setting 'Send Mode Setting
copo et [ameacion = N T
e

File Name® il I Mail Setting
Date Format

File Type®
Mail Address™

ne address is entered, se
with( ) Example-123@foxmail com 456@foxmail
com

‘Send Frequency
Send Frequency {The Maximum Lengths0

e [The Maximum Length200
e

Select All e
—  wlhouwr: — - minute

— o~ hor: — - |minute




® The SIP service mode has been moved to the Video Intercom — Parameters page.

The "SIP Service Mode" option in System — Cloud Settings has been hidden.

ZKBio CVAccess 3

[ VRSNV  System / System Management / Cloud Settings

Operation Log

Cloud Settings

Data Management
Area Settings Enable

E-mail Management No (&) Yes
Dictionary Management
Data Cleaning No (3 Yes
Resource File

http:/192.168.5.10:8888

Certificate Type
AT
Message Notification

Parameters

APP enterprise QR cod

The cloud service.
address does not exist
oris configured
incorrectly

® Authority Management
@ Communication Mana...

& Third Party Integration

A new "SIP Service Mode" option has been added to Video Intercom — Parameters .

(JZKBio CVAccess 3

B Basic Management Video Intercom / Basic Management / Parameters

Building
DTMF Setting
Unit

DTMF:

APP Call Number Type Setting

Gall Number Type
&) Extension Number

Is pushing event data to the cloud platform enabled

ZKBio CVConnect Server Url

ZKBio CVConnect Client

e

SIP Account

SIP Service Mode Configuration

SIP Service Mode
Cloud SIP

AT

3rd-Party PBX Server

ZKBio CVHyperSync

Device Management

Extension Management

Access Management

Video Intercom Reports

OB O T~

e ]

0O & O Tt v

APP Call Number Type Setting

SIP Service Mode Configuration



Smart Video Surveillance

® Integrated with TP-Link NVR to enable preview, playback, intelligent alert display,
and alarm linkage.

Operating Steps:

Step1: Enter Smart Video Surveillance — Device Management — Device,Click "New" under the main

device list to display the adding interface as shown in figure below.

Step2: You can choose NVR devices based on the TP-Link protocol.

MNew x

4

Protocol Type* | TPLink

4

Type® 'NVR

Mame® [

Address® |

Port’ 20443

User Name®

i
Password® |

"o I




The description of each parameter is shown in Table.

Parameters/Buttons Description

Type Select the device type.

Protocol Type Select the type of protocol.

Name Customize the device name.

Port Configure the device port.TPLink NVR default is 20443.

Configure the device address. The format is: xxx.xxx.xxx.xxx, for example:

Address 192.168.6.5

Username &
Password

Step 3: Click OK.

The NVR'S user name and password.

ZKBio CVAccess i % Q& 0 w-
Device Management N smart Video Surveillance / Device Management / Device
Bevee: Name Status ~] e & e Device Name: 1P Address Morer Q B <
Group Management
G Refresh =¥ New @ Delete Q Search ® Sync Camera & Batch Sync Library - More ~ G Refresh  T#New @ Delete Q Search [ Adjustment Area @ Video Storage - More
Name Address Protocol Type Device Type  Status Subseri. Operations Device Name Channel Code Status  Camera Type Tvpe IP Address
New x
Protocol Type* TPLink. ¥
Type" NVR A
Name* TPlink
Address” © s 1 5
Port" 20443
User Name™ admin 5
Password'  seeesseen
Nocta
Cancel

Video View

B2 pecoding On The Wall

&)

Intelligent

Statistics

% Video Patrol

Map Management
‘ »
< ¢ 0 5 5 S0rowsperpage - JumpTo 1 /0Page  Total of 0 records 1< ¢ 0 5 5 50rowsperpage ~ JumpTo 1 JoPage  Total of 0 records

Maintenance Configur...

10 tp-link | VIGI Playback Information Settings admin  Logout

Camera

Device Access

Add Manually

) Channel Na




The software interface will automatically synchronize the added camera devices.
Enter Smart Video Surveillance > Video View > Video Preview.

You can view the video preview here.

OB O Tt~

ZKBio CVAccess i 38
Device Management > Smart Video Surveillance / Video View / Video Preview
Groue
¥ Video View -
Video Playback
El TPLink (8/8)

12

Decoding On The Wall >

D

{Z intelligent > o a 0
- L -
® statistics > I l l
&, Video Patrol >
& Map Management >
PTZ Gorirol testace G &4 $ GPU: 39% Hemony: 3% Disk. 0% Downward OMbps Upward: Ohops B X L3
@l Maintenance Configur... > ? <6

Enter Smart Video Surveillance > Video View > Video Playback.

You can view the video playback here.

Enter Smart Video Surveillance > Intelligent > Live Alarm.

You can view real-time video alarm monitoring here.

Enter Smart Video Surveillance > Intelligent > Global Linkage, click New to set the video linkage.

O @ mw -

ZKBioCVAccess i 3
[FY G e Smart Video Surveiliance / Intelligent / Global Linkage
Global Linkage < Browse Personnel >
Cd Video View
N o —
i i | @B e
G2 Decoding On The Wall  —
Linkage Name™ Apply To Al
Intelligent CRefresh  =F New B Delete  active Time Zone - Active Time To
" Linkage Name Linkag Linkage Trigger Condiions”  Add. Input Point  Add
Choose Linkage Trigger Conditions x
Type | TPLInk =
5 Normal alarm =
Live Alarm [ Motion Detection
[ Video Tampering
Clobalii ke [ Object LefiLost
o) Retord B Intelligent alarm
¥ Video Linkage [E Wandering Detection Alarm i
[ Region Exiting Alarm
) [ Intrusion Detection Alarm
FplaE [ Cross Line Detection Alarm N
[5 Region Entrance Warning
[ Scene Change Alarm
B areceae No data
Cancel
Statistics >
o e
. Video Patrol
Map Management
1< < 0 5 > S0rowsperpage - JumpTo 1 JoPage  Total of 0 records 1< < 0 5 5 50rowsperpage = JumpTo 1 /o Page  Total of 0 records

Maintenance Configur... >




® Supports batch synchronization of list databases to multiple devices.

Step1: Enter Smart Video Surveillance = Device Management — Device, and click "Batch Sync Library".

(JZKBioCVAccess i 3t Q08 O -

[ EUTIRUMPRNII  Smat Video Surveillance / Device Management / Device

Group Management
O Refresh ¥ New @ Delete Q Search & Sync Camera:] More O Refresh ¥ New @ Delete [ Adjustment Area @ Video Storage ~ More

Name. Address Protocol Type  Device Type  Status Subscri_.  Operations Device Name. Channel Code  Status ~ Camera Type  Type 1P Address

-] a R e Device Name 1P Address Morer Q B

X1 192168.137.99  ZKIVA-Edge X1  AiBox -] 2

No data

Video View

Decoding On The Wall

D

Intelligent

Statistics

Video Patrol

Map Management
‘ »
11 50 rows per page Jump To 1 11Page  Total of 1 records 0 50 rows per page Jump To 1 JoPage  Total of 0 records

Maintenance Configur...

ZKBio CVAccess ® OB 0w

[T ORI smart Video Surveillance / Device Management / Device

Device Name | status —— -l QB e Device Name. | 1P Address | | Morer Q B €

ORefresh T New @ Delete QSear = = - - A==y @oelete QSearch (S AdjustmentArea @ Video Storage - More
Batch Sync Library x
Name. Address ‘ ‘ Channel Code  Status  Camera Type Type IP Address
Name | ] @ B ¢
Atterative Setected(0)
List Library...  List Library List Library...  List Library
Pass List Allow List
Forbidden List Block List
= L.
Nojdeta No data
Video View
Decoding On The Wall
Intelligent -2 50 rows per page ‘d!
Cancel
Statistics
., Video Patrol
Map Management
‘4 »
& ¢ 0 5 3 SOrowsperpage * JumpTo 1 /0Page  Total of 0 records 1 ¢ 0 5 s s0rowsperpage v JumpTo 1 J0Page  Total of O records

Maintenance Configur...

Step3: Select the devices for which you want to synchronize the list (multiple can be checked at once),
move them to the right, and click "OK" to complete the list library synchronization.



CVAccess

Device Management

Smart Video Surveillance / Device Management / Device

Device Name | | stotus [—— 7] [@ & & Device Name | ipadiess | - Q B ©
Group Manag
CRefresh ¥ New @ Delete  Q Sea w W Delete (2] Adjustment Area @ Video Storage - More ~
Name Address Channel Code Status  Camera Type Type IP Address
® X1 192.168.137.99
Name Q B ¢
Alternative Selected(0)
Name Address Name Address
x1 192.168.137.99
> £
No data No data.
Decoding On The Wall
Intelligent 1-1 50 rows per page Q
Cancel
Statistics.
Video Patrol
Map Management
’
e Ko< 11 > 3 50 rows per page - JumpTo 1 /1 Page  Total of 1 records K< 0 > 0 50 rows per page = Jump To 1 10 Page  Total of 0 records
Data will start to be imported automatically until the operation completion prompt is given.
® Support linkage with IPC (access control or video linkage with IPC).
Can directly bind IPC devices (not limited to IPC devices in NVR devices)
()ZKBio CVAccess H] 08 O -
_ Name Status - [@ = @ Devce Name 1P Address wrew Q B @
Group Management
G Refresn  # New W Delete Q Search & Sync Camera & Batch Sync Library More G Refresh (@] Adjustment Area More
Name Address Protocol Type Device Type Status Subscri. Operations Device Name Channel Code Status  Camera Type Type IP Address
38 192.168.137.38  ONVIF IPC ) 4 cH1 1 Fixed Camera 192.168.137
x1 192.168.137.99  ZKIVA-Edge X1  AiBox 2
Video View
2 Dpecoding On The Wall
Intelligent §
Statistics
Video Patrol
Map Management
’ ;
12 50 rows per page JumpTo 1 I1Page  Total of 2 records 11 50 rows per page Jump To 1 11 Page  Total of 1 records

Maintenance Configur...




Binding/unbinding the camera

Channel Name | Serial Number | ] @ B €

Selected(0)

Serial Num

10dcer2dat22]

71979020917b: =
x1 03172220b7814
x1 425bbdaae32t e
X1 808688161765

1 amsEsn x 08e4a3c782dd 7
1< < 19 5 51 50 rows perpage

o

Note: Due to the inconsistent SDK interface standards among different brands of cameras, some
devices do not support snapshot interfaces, making it impossible to implement linked snapshot
functionality. For the specific models of devices that are supported, you may contact the technical
support team to obtain the device compatibility list for verification.



Service Center

® Event Center-Supports batch selection and processing of events.

In the event record list, after selecting multiple events and clicking Confirm, enter the confirmation
details and save. The processing status of the selected events will then change to "Confirmed".

LI~ Collapse quick input




® Video preview, playback, and PTZ control.

The APP has added a Smart Video Surveillance module. The main updates include support for video
preview, video playback, PTZ control, video snapshot, manual recording, and intercom functions.

Note: The video stream of the ZKBio Zexus APP uses the T-cloud protocol. Only devices that support
this protocol can view it in the APP.Currently, only devices with the latest ZKTECO firmware are

supported. Third-party devices are not supported for management in the APP.

Operation (Administrator): Click on the Application Center -> Video Monitoring to enter the video
view function. On the home page of this function.

6:04 Z ol all

Application Center a)

1ZKBio CVSecurity. ECl6 DEX16

Elevator Control

L )

Elevator Unlock

Smart Video Surveillance

—

Video Monitoring

Intrusion Alarm

Arm/Disarm Intrusion Record

Visitor Management

B o &

Dashboard Alarm Center Application Ce Me

You can view the device list and the current screen.



6:04 Lt =

< Video Monitoring

® 192168.54.251

@ 53192168.54.252

B9 192.168.54.131

By clicking on the device, you can perform playback, PTZ control, snapshot, manual recording, and

intercom operations.

6:04 Z il .l = @ 6:09 Al =

< 192168.54.251 £ ~%%~%34567890~234567890~2... (a8

F7

Alarm Message . Alarm Message

@ Lens Occlusion Warning 2025-10-13 18:08:37.0

@ Lens Occlusion Warning 2025-10-13 18:08:37.0

@ Lens Occlusion Warning 2025-10-13 18:08:37.0
No Data



B Playback:

The playback of the picture can be achieved by dragging the timeline below. The playback page allows
you to continue taking snapshots, manually record videos, or adjust the speed through "Speed". There

are three speed Settings available:x 0.5, x1, and x2.

6:05 2l =

13/10/2025

22

m PTZ:

The camera can be remotely controlled in terms of direction, with a minimum adjustment angle of 45
degrees. It also allows for zooming in and out of the picture, focus control, and adjustment of the

camera's movement speed, ranging from 1 to 10.

You can save the preset position. Click "Save" at the current position to save the current position, and
click "Call" to quickly restore to the saved position. It supports saving up to 255 preset positions at most.

6:05 Al =

A — Zoom +
v <

AUTO » — Focus +
b 4

v — Speed:5 +

Preset 1



B Snapshot:

Click "Snapshot" to capture the scene. You can save and forward the captured pictures.After clicking

the download button, the captured image will be saved to the phone's album.

A allall R @

B Manual Record:

Click "Manual Record" to achieve the video recording from the moment of clicking to the moment of
clicking again.The video can be downloaded and forwarded.Click the download button and the video

can be downloaded to your phone's album.

Z il all = @




B Intercom:

Click "Intercom" to activate real-time communication with the video scene through video intercom.

6:09 Zall.al @D

{ ~%%~%34567890~234567890~2... (a8

Alarm Message

@ Lens Occlusion Warning 2025-10-13 18:08:37.0
@ Lens Occlusion Warning 2025-10-13 18:08:37.0

@ Lens Occlusion Warning 2025-10-13 18:08:37.0

® Background message notifications can redirect to the details page.

A new function for viewing message details has been added. When there are message push
notifications in the background, clicking on the message will redirect you to the message details page.

T EEEE W SRR TR WL to
2025-10-14 18:23:00DL-CS2.




® Added a"Card Number" field to the personnel registration interface.
Operation (Administrator End) :

Enter the Application Center -> Personnel Management -> Personnel Registration to register personnel
information.

4:05 Ll = 4:07 Ll T @

Application Center A < Personnel Registration

Department*  kara

Personnel ID* m
First Name* Jh
Last Name
Personnel Management
Email* Jhying@hybe.com
Mobile Phone
Personnel
Registration
PIN* 123456
Access Control
Card Number 1234567
General
Remote Control  Lockdown  Access Records Access Level
Elevator Control Validity Period

w Start Time

Elevator Unlock
[ Enable APP Login

— ]
10} 0 & Submit
Dashboard Alarm Center Application Ce Me

Note: Only one card number can be registered. Multiple card registrations are not supported.
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